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1. ระบบ E-Learning 

e-Learning ย่อมาจากค าว่า Electronic Learning ซึ่งเป็นการเรียนการสอนผ่านทางสื่อ
อิเล็กทรอนิกส์ ในรูปแบบต่างๆ เช่น วิทยุกระจายเสียง (Radio), โทรทัศน์ (TV), เครือข่ายอินทราเน็ต 
(Intranet), และเครือข่ายอินเทอร์เน็ต (Internet) โดยที่ผู้เรียนสามารถเรียนรู้เพ่ือพัฒนาตนเองได้ทุกที่ และ
ตลอดเวลา ผ่านทางหน้าเว็บไซต์ในรูปแบบสื่อมัลติมีเดีย ไม่ว่าจะเป็นข้อความ เสียง ภาพน่ิง ภาพเคลื่อนไหว และวีดีโอ 
อีกทั้งผู้เรียนสามารถท าการโต้ตอบกับสื่อมัลติมีเดียได้ เสมือนการน่ังเรียนในห้องเรียนปกติ 

 
2. แนะน าโปรแกรม Adobe Captivate 5.0 

Adobe Captivate เป็นโปรแกรมที่ใช้ส าหรับสร้างสื่อการเรียนการสอน หรือสื่อการน าเสนอในรูปแบบ 
Interactive Multimedia ที่สามารถสร้างสื่อมัลติมีเดียได้หลากหลายรูปแบบ เช่น การจับภาพหน้าจอเพ่ือน าไป
สร้างสื่อการเรียนการสอน การสร้างสื่อน าเสนอจากข้อมูลต่างๆ ทั้งข้อความ และรูปภาพ การสร้างแบบทดสอบ โดยสื่อ
น าเสนอที่ถูกสร้างขึ้นสามารถน าไปเผยแพร่ต่อทางด้าน E-Learning หรือระบบออนไลน์บนอินเทอร์เน็ต 

 
3. ความตอ้งการของระบบส าหรบัตดิตัง้โปรแกรม 

3.1 ระบบปฏิบัตกิาร Windows XP หรือ Windows 7 
3.2 ซีพียู ควรจะเป็น Intel Pentium 4 ข้ึนไป 
3.3 หน่วยความจ า RAM ไม่น้อยกว่า 512 MB  
3.4 พ้ืนที่ฮาร์ดดสิ ไม่น้อยกว่า 15 GB 
3.5 การด์จอทีร่องรับการแสดงผลอย่างน้อย 800x600 pixels 
3.6 โปรแกรมเว็บบราวเซอร ์เช่น Internet Explorer 6 ข้ึนไป 
3.7 โปรแกรม Adobe Flash Player 7 
3.8 โปรแกรม Macromedia Shockwave Player 
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4. หนา้ตา่งเริม่ตน้ของโปรแกรม Adobe Captivate 5.0 (Welcome Screen) 

เม่ือเริ่มต้นเปิดโปรแกรมข้ึนมา จะแสดงหน้าต่างเริ่มต้นของโปรแกรม ซึ่งประกอบด้วยส่วนต่างๆ ดังน้ี 
 

 
 
 
4.1 Open Recent Item 

เป็นสว่นของการแสดงรายการไฟล์โครงการลา่สุดที่มีการเปิดใช้งาน และเมนู Open ส าหรับเปิดใช้งานไฟล์โครงการ
ที่มีการบันทึกไว ้
4.2 Create New 

เป็นการเริ่มต้นการสร้างโครงการข้ึนใหม่ โดยโปรแกรมมีรูปแบบของโครงการตา่งๆ ให้เลือกใช้งาน ดังน้ี 
1. Software Simulation 

เป็นการสร้างโครงการในรูปแบบของการบันทึกหรือจับภาพการท างานของโปรแกรมหรือหน้าจอที่ต้องการ เพ่ือ
น าไปสร้างงานน าเสนอ หรือสื่อการเรียนการสอนด้านซอฟต์แวร์คอมพิวเตอร์ 

4.1 

4.2 

4.3 

4.4 
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2. Blank Project 

เป็นการสรา้งโครงการจากรูปแบบของโครงการเปลา่ ซึ่งต้องท าการแทรกวัตถุตา่งๆ ปรับแต่ง และก าหนดการ
แสดงผลดว้ยตัวเอง 

3. From Microsoft PowerPoint 
เป็นการสร้างโครงการด้วยการน าเข้าไฟล์พรีเซนเตชั่นของโปรแกรม Microsoft PowerPoint เข้ามาสร้าง

เป็นสไลด์ของโครงการ 
4. Image Slideshow 

เป็นการสร้างโครงการรูปภาพพรีเซนเตชั่น โดยสามารถน าเข้ารูปภาพต่างๆ มาใช้ เป็นสไลด์ของโครงการ แล้ว
ส่งออกมาเผยแพร่ในรูปแบบต่างๆ ได้ 

5. Project Template 
เป็นการสร้างแม่แบบของโครงการ (Template) เพ่ิมข้ึนมา และบันทึกเพ่ือเก็บไว้ใช้เป็นแม่แบบในการสร้าง

โครงการอ่ืนๆ ได้ 
6. From Template 

เป็นการสร้างโครงการโดยเลือกจากแม่แบบที่โปรแกรมมีมาให้ ซึ่งแม่แบบจะถูกติดตั้งมาพร้อมกับโปรแกรม และ
ถูกเก็บไว้ในไดเรกทอรี My Document > My Adobe Captivate Project > Templates > Project 
Templates หรือสามารถดาวน์โหลดมาจากเว็บไซต์ของ Adobe ได้ 

7. Aggregator Project 
ในการสร้างโครงการที่มีการแบ่งเน้ือหาออกเป็นหลายส่วน สามารถเลือกสร้างแยกส าหรับแต่ละเน้ือหา จากน้ัน

ส่งออกโครงการให้อยู่ในรูปไฟล์ SWF แล้วน าไฟล์ SWF ของแต่ละเน้ือหามารวมเป็นโครงการเดียวกันอีกครั้ง  
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4.3 Tutorials 

เป็นสว่นของการแนะน าวิธกีารสรา้งโครงการ และการใช้เครื่องมือต่างๆ ของโปรแกรม ในรูปแบบของ Flash 
Video 

 

 
 
4.4 การปดิการแสดงหนา้ตา่งเริม่ตน้ของโปรแกรม (Welcome Screen) 

ในการใช้งานโปรแกรม หากไม่ต้องการให้ส่วนของหน้าต่างเริ่มต้นของโปรแกรม แสดงขึ้นมาตอนเริ่มต้นเปิดโปรแกรม 
สามารถคลิกที่เช็คบ็อกซ์ “Don’t Show Again” หรือก าหนดได้ที่เมนู Edit > Preferences > General 
Settings แล้วคลิกเพ่ือยกเลิกการแสดงส่วนของหน้าต่างเริ่มต้นของโปรแกรมที่เช็คบ็อกซ์ “Show Welcome 
Screen” 
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5. สว่นประกอบของเมนกูารใชง้านโปรแกรม 

 

 
 
 
5.1 แถบเมนบูาร ์(Menu Bar) 
 

      
 

เป็นเมนูที่รวมเครื่องมือ และค าสั่งทั้งหมดของโปรแกรม ซึ่งประกอบด้วยเมนูต่างๆ ต่อไปน้ี 
1. File เป็นเมนูที่รวมค าสั่งในการจัดการโครงการ ซึ่งประกอบด้วยค าสั่งส าหรับสร้าง/เปิดไฟล์ที่ต้องการ การ

บันทึก การน าเข้า/การส่งออกไฟล์เพ่ือใช้งาน การเผยแพร่ และการแสดงผลโครงการในรูปแบบต่างๆ 
2. Edit เป็นเมนูที่รวมค าสั่งในการแก้ไขส่วนต่างๆ ของโครงการ ซึ่งประกอบด้วยค าสั่งส าหรับคัดลอก วางภาพ 

ข้อความ หรือสไลด์ การส าเนาสไลด์ และการก าหนดหรือแก้ไขค่าพ้ืนฐานให้กับโครงการ (Preference) 

5.2 

5.1 

5.3 

5.4 

5.5 

5.6 

5.7 

5.8 

5.9 
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3. View เป็นเมนูที่รวมค าสั่งในการปรับเปลี่ยนขนาดมุมมองของสไลด์ หรือพ้ืนที่ท างาน การซ่อน/แสดงสไลด์ 

และการเปิดใช้งานเส้นกริด 
4. Insert เป็นเมนูที่รวมค าสั่งในการแทรกวัตถุต่างๆ เข้ามาบนพ้ืนที่การท างานหรือสไลด์ ซึ่งประกอบด้วยค าสั่ง

ส าหรับเพ่ิมสไลด์ เพ่ิมข้อสอบ แทรกภาพน่ิง ภาพเคลื่อนไหว ข้อความ และปุ่ม 
5. Modify เป็นเมนูที่รวมค าสั่งในการปรับเปลี่ยนขนาดหน้าจอการแสดงผล การก าหนดต าแหน่ง และการ

จัดเรียงวัตถุต่างๆ บนหน้าจอ 
6. Project เป็นเมนูที่รวมค าสั่งในการจัดการโครงการ หรือสไลด์ทั้งหมด ซึ่งประกอบด้วยค าสั่งส าหรับสร้าง

ตารางสารบัญให้กับโครงการ การก าหนดแม่แบบแผงควบคุม (Skin Editor) และการก าหนดตัวแปร 
7. Quiz เป็นเมนูที่รวมค าสั่งในการสร้างแบบทดสอบในรูปแบบต่างๆ และการตั้งค่าแบบทดสอบ 
8. Audio เป็นเมนูที่รวมค าสั่งในการจัดการเสียงออดิโอ เสียงเพลง ซึ่งประกอบด้วยค าสั่งส าหรับบันทึกเสียง 

การน าเข้า และการตัดต่อเสียง 
9. Video เป็นเมนูที่รวมค าสั่งในการจัดการไฟล์วิดีโอ การแทรกไฟล์วิดีโอ โดยไฟล์วิดีโอที่สามารถใช้งานได้ เช่น 

flv, avi, mov, mp4 และ 3gp 
10. Window เป็นเมนูที่รวมค าสั่งในการเปิดใช้งานเครื่องมือต่างๆ ของโปรแกรม รวมถึงการปรับแต่งขนาดของ 

Filmstrip 
11. Help เป็นเมนูที่รวมลิงค์เพ่ือเชื่อมต่อไปยังเว็บไซต์ของ Adobe ซึ่งสามารถดูคู่มือการสร้างโครงการ และการ

ใช้งานโปรแกรม Adobe Captivate ได้ 
 

5.2 แถบเครือ่งมือมาตรฐาน (Standard Tools) 
 

 
 

เป็นสว่นที่แสดงเครื่องมือมาตรฐานที่มีการใช้งานบ่อย เพ่ือสะดวกต่อการเรียกใช้งาน ประกอบดว้ยเครื่องมือต่างๆ 
เช่น บันทกึ ท าซ้ า ยกเลกิการท าซ้ า ตดั คัดลอก วาง ส าเนา บันทึกวิดโีอ บันทึกเสียง และการซ่อน/แสดงเส้นกรดิ 

 

5.3 แถบเครือ่งมือ Object Toolbar 
 

 
 

เป็นสว่นที่แสดงวัตถุ (Object) ต่างๆ ทีส่ามารถแทรกบนสไลด์ เพ่ือตกแต่งสไลด์ของโครงการได้ เช่น ข้อความ 
กล่องข้อความ 
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  Text Caption (กล่องข้อความ) เป็นวัตถุที่ใช้ส าหรับแทรกข้อความลงบนสไลด์ของโครงการ 

  Rollover Caption (กล่องข้อความโรลโอเวอร์) เป็นวัตถุที่ใช้ส าหรับแสดงข้อความโรลโอเวอร์ ซึ่งเป็นข้อความ
ที่จะแสดงขึ้นมา ก็ต่อเม่ือน าเมาส์ไปชี้เหนือพ้ืนที่โรลโอเวอร์ของข้อความเท่าน้ัน 

  Highlight Box (กล่องไฮไลน์) เป็นวัตถุกล่องสี่เหลี่ยม สามารถก าหนดรูปแบบการแสดงผลได้ ใช้ในการเน้น
เฉพาะจุดหรือข้อความ เพ่ือให้เน้ือหาของสไลด์มีจุดเด่นมากข้ึน 

  Click Box (กล่องคลิกบ็อกซ์) เป็นวัตถุที่ใช้ส าหรับจ ากัดขอบเขตในการคลิกเมาส์ของผู้ใช้บนสไลด์ของโครงการ 
ซึ่งสามารถก าหนดให้เกิดการเปลี่ยนแปลงหรือแสดงผล เม่ือผู้ใช้ท าการคลิกเมาส์บนพ้ืนที่ที่ก าหนดไว้เท่าน้ัน 

  Button (ปุ่ม Button) เป็นปุ่มค าสั่งแบบโต้ตอบ ซึ่งโปรแกรมมีแม่แบบให้เลือกมากมาย และสามารถเชื่อมโยง
ไปยังเหตุการณ์ต่างๆ ได้ เช่น ตกลง, ไปหน้าถัดไป หรือไปหน้าแรก เป็นต้น 

  Text Entry Box (ช่องกรอกข้อความ) เป็นวัตถุที่ใช้ส าหรับก าหนดให้ผู้ใช้กรอกข้อความ เช่น กรอกชื่อ-
นามสกุล ที่อยู่ หรือเบอร์โทรศัพท์ เป็นต้น 

  Rollover Slidelet (โรลโอเวอร์สไลด์) เป็นสไลด์ที่แทรกเข้ามาในสไลด์ของโครงการ โดยจะแสดงผลก็ต่อเม่ือ
น าเมาส์ไปชี้เหนือพ้ืนที่โรลโอเวอร์ของสไลด์เท่าน้ัน  

  Zoom Area (พ้ืนที่ขยายขนาด) เป็นวัตถุที่แทรกบนสไลด์ เพ่ือเน้นจุดที่ต้องการซูมขยายขนาด เพ่ือให้เห็น
ภาพได้ชัดเจนข้ึน  

  Mouse (ตัวชี้เมาส์) เป็นวัตถุที่แสดงการเคลื่อนที่ของตัวชี้เมาส์ นิยมใช้ในการสร้างโครงการประเภท 
Software Simulation 

  Text Animation (ข้อความแอนิเมชั่น) เป็นข้อความแบบแอนิเมชั่น ซึ่งโปรแกรมมีแม่แบบเตรียมไว้ให้มากมาย 
 

5.4 แถบ Filmstrip 
 

 
 

เป็นส่วนที่แสดงภาพสไลด์ขนาดย่อ เรียงต่อกันเป็นล าดับก่อนหลังตามการน าเสนอ ซึ่งช่วยให้สะดวกในการเลือก
สไลด์เพ่ือท าการตกแต่งหรือแก้ไข 
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5.5 แถบไทมไ์ลน ์(Time Line) 
 

 
 

เป็นส่วนที่แสดงระยะเวลาที่แต่ละสไลด์ และวัตถุบนสไลด์ใช้ในการแสดง ซึ่งจะแสดงแยกเป็นเลเยอร์ต่างๆ  
 

5.6 สไลดโ์นต๊ (Slide Note) 
 

 
 

เป็นส่วนที่แสดงอยู่ด้านล่างของหน้าต่างโปรแกรม ส าหรับแทรกค าอธิบายให้กับสไลด์ที่เลือก เพ่ือเตือนความจ า 
หรืออธิบายรายละเอียดเพ่ิมเติมเกี่ยวกับสไลด์ 

 

5.7 พืน้ทีท่ างาน (Work Space) 
 

 

 
เป็นส่วนที่แสดงพ้ืนที่การท างาน หรือสไลด์จากการเลือก

ภาพของสไลด์บนแถบ Filmstrip ซึ่งสามารถท าการสร้าง แก้ไข 
แทรก หรือตกแต่งวัตถุต่างๆ ได้ 

 
 

5.8 แถบไลบรารี ่(Library) 
 

เป็นส่วนที่รวบรวมไฟล์ หรือวัตถุที่ถูกน ามาใช้ในการตกแต่งสไลด์ของ
โครงการ ซึ่งสามารถน ากลับมาใช้ใหม่ได้ โดยไม่ต้องท าการน าเข้ามาอีกครั้ง โดย
โปรแกรมจะจัดแยกไฟล์เป็นโฟลเดอร์ตามประเภทของไฟล์ เช่น รูปภาพ (Images) 
เสียง (Audio) 
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5.9 แถบสถานะ (Status) 
 

 
 

เป็นสว่นที่แสดงไดเรกทอร ีหรือต าแหน่งที่อยู่ของไฟล์โครงการ และขนาดสไลด์ของโครงการ 
 

6. การสรา้งโครงการจากสไลด ์PowerPoint 
การสร้างโครงการจากสไลด์ PowerPoint เป็นความสามารถหน่ึงของโปรแกรม Adobe Captivate โดยสามารถ

น าเข้า (Import) สไลด์ที่สร้างขึ้นด้วยโปรแกรม Microsoft PowerPoint มาใช้เป็นสไลด์ของโครงการได้  
6.1 ขัน้ตอนการสรา้งโครงการจากสไลด ์PowerPoint 

1. สามารถเริ่มต้นสร้างโครงการจากหน้าต่างเริ่มต้นโปรแกรม ที่ส่วนของเมนู Create New ท าการเลือก 
From Microsoft PowerPoint > 

 

 
 

2. โปรแกรมจะแสดงหน้าต่าง Open ข้ึนมา ให้ท าการเลือกไดเรกทอรี หรือโฟลเดอร์ที่บันทึกไฟล์ Microsoft 
PowerPoint และเลือกไฟล์ของ Microsoft PowerPoint ที่ต้องการน าเข้าไปในโครงการ และท าการเลือก Open 
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3. โปรแกรมจะท าการประมวลผล เพ่ือน าเข้าไฟล์ Microsoft PowerPoint ที่เลือก ให้รอจนกระทั่งการ

ประมวลผลเสร็จสิ้น ซึ่งระยะเวลาในการประมวลผลจะข้ึนอยู่กับจ านวนสไลด์ของไฟล์ และความเร็วของเครื่องคอมพิวเตอร์ 
 

 
 

4. เม่ือโปรแกรมประมวลผลเสร็จสิ้น จะปรากฎหน้าตา่ง Convert PowerPoint Presentations  
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4.1 สว่นของ Project Properties 

1) Name – การก าหนดชื่อให้กับสไลด์ Microsoft PowerPoint 
2) Width และ Height – การก าหนดขนาดของสไลด ์โดยสามารถท าการก าหนดเอง หรือเลือก

จาก Drop Down List ของ Preset Sizes ซึ่งมีขนาดต่างๆ ของสไลด์ให้เลือกได ้เช่น 960x720 
ขนาดมาตรฐานของสไลด ์Microsoft PowerPoint 

3) Maintain aspect ratio – ท าการปรับขนาดของสไลดใ์ห้สัมพันธ์กัน 
4.2 สว่นของ Slide Preview จะแสดงสไลด์ทั้งหมดของไฟล ์Microsoft PowerPoint ที่น าเข้ามา  

สามารถคลกิเช็คบ็อกซเ์พ่ือเลือกเฉพาะสไลด์ที่ต้องการได ้
4.3 สว่นของ Advance Slide เป็นการก าหนดรูปแบบการแสดงผลสไลด์ที่น าเข้าในโครงการ ซึง่มี 2 

รูปแบบ คือ 
1) On mouse click – ก าหนดให้ไปยังสไลด์ถัดไป เม่ือท าการคลิกเมาส์ 
2) Automatically – ก าหนดให้แสดงสไลดถ์ัดไปโดยอัตโนมัติ 

5. เม่ือเลือกสไลด์ที่ต้องการน าเข้าเสร็จแลว้ คลกิที่ปุ่ม OK  
 

 
 

6. โปรแกรมจะท าการแปลงสไลด์ที่เลือก มาเป็นสไลด์ของโครงการ ให้รอจนกว่ากระบวนการจะเสร็จสิ้น โปรแกรม
จะแสดงสไลด์ของ Microsoft PowerPoint ที่เลือกบนแถบ Filmstrip ซึ่งสามารถท าการตกแต่ง หรือแก้ไขการ
แสดงผลเพ่ิมเติมได้ 
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6.2 การก าหนดคณุสมบตัใิหก้บัสไลด ์(Slide Properties) 
Slide Properties เป็นหน้าต่างส าหรับก าหนดคุณสมบัติให้กับสไลด์ เช่น ชื่อ รูปแบบการแสดงสไลด์ ซึ่งมี

ข้ันตอนการก าหนดค่าดังน้ี 
1. Label – เป็นการก าหนดชื่อของสไลด์ โดยหากไม่ก าหนดชื่อให้ โปรแกรมจะก าหนดให้ชื่อ Slide ตามด้วย

ตัวเลขเรียงล าดับแทน 
2. Quantity – เป็นการก าหนดระดับคุณภาพให้กับสไลด์ ซึ่งสามารถก าหนดได้เป็นระดับคุณภาพ Low (8-

bit), Optimized, JPEG หรือ High (24-bit) โดยในแต่ละระดับคุณภาพของสไลด์ จะมีผลท าให้ขนาดของไฟล์
เพ่ิมมากข้ึน และระยะเวลาในการดาวน์โหลดไฟล์ที่เพ่ิมข้ึนด้วย 

3. Display Time – เป็นการก าหนดระยะเวลาในการแสดงสไลด์ มีหน่วยเป็นวินาที ซึ่งค่าสูงสุดที่สามารถ
ก าหนดได้ คือ 1 ชั่วโมง (3600 วินาที) 

4. Transition – เป็นการก าหนดรูปแบบ (Effect) ของการเปลี่ยนช่วงแต่ละสไลด์ในโครงการ ซึ่งโปรแกรมมี
ไว้รองรับหลายรูปแบบ 
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5. On Enter – เป็นการก าหนดเหตุการณ์ที่จะเกิดข้ึนเม่ือเข้าสู่สไลด์ โดยโปรแกรมมีเหตุการณ์ต่างๆ ส าหรับใช้

งาน ดังน้ี 
1) Continue – ก าหนดให้ไปยังสไลด์ถัดไป 
2) Open URL or file – เชื่อมโยงเว็บไซต์หรือไฟล์ที่อยู่ในไดเรกทอรีของคอมพิวเตอร์ ซึ่งจะแสดงใน

รูปแบบของเว็บบราวเซอร์ หรือรูปแบบอ่ืนๆ 
3) Open another project – ก าหนดให้เปิดโครงการอ่ืนที่มีการบันทึกอยู่บนคอมพิวเตอร์ 
4) Sent e-mail to – ก าหนดให้ส่งอีเมล์ถึงที่อยู่ของอีเมลแอดเดรสที่ระบุไว้ 

6. On Exit – เป็นการก าหนดเหตุการณ์ที่จะเกิดข้ึนเม่ือออกจากสไลด์ โดยโปรแกรมมีเหตุการณ์ต่างๆ ส าหรับ
ใช้งาน ดังน้ี 

1) Go to the previous slide – ก าหนดให้ไปยังสไดล์ที่ผ่านมา หรือสไลด์ก่อนหน้า 
2) Go to the next slide – ก าหนดให้ไปยังสไลด์ถัดไป 
3) Go to the slide last visited – ก าหนดให้ไปที่สไลด์ล่าสุดที่ผ่านมา 
4) Jump to slide – ก านหนดให้ไปยังสไลด์ที่ก าหนไว้ 
5) No Action – ไม่ก าหนดเหตุการณ์ใดๆ ให้กับสไลด์ 

 
6.3 การแสดงตวัอยา่งผลลพัธข์องโครงการ (Preview) 

เป็นการแสดงตัวอย่างผลลัพธ์ของโครงการที่สร้างอยู่ในขณะน้ัน ด้วยรูปแบบต่างๆ โดยเรียกใชค้ าสั่ง Preview ที่
เมนู File > Preview ซึ่งสามารถเลือกรูปแบบการแสดงผลได้ดังน้ี 

1) Play Slide (F3) ท าการแสดงตัวอย่างผลลัพธ์ของสไลด์ที่ก าลังท างานอยู่ ในส่วนของพ้ืนที่ท างาน 
(Work Space) 

2) Project (F4) เป็นการแสดงตัวอย่างผลลัพธ์ทั้งหมดของโครงการ ด้วยการแปลงโครงการให้อยู่ในรูปแบบ
ของไฟล์ Flash (SWF) แล้วจึงแสดงผล 

3) From this Slide (F8) ก าหนดให้ท าการเริ่มต้นแสดงตัวอย่างผลลัพธ์ของโครงการตั้งแต่ลไลด์ที่เลือก 
4) Next 5 Slides (F10) ก าหนดให้แสดงตัวอย่างผลลัพธ์ของโครงการตั้งแต่สไลด์ที่เลือก ไปถึงอีก 5 

สไลด์ถัดไป 
5) In Web Browser (F12) ก าหนดให้แสดงตัวอย่างผลลัพธ์ทั้งหมดของโครงการ ในหน้าต่างของเว็บ

บราวเซอร์ 
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6.4 การแทรกสไลด ์Microsoft PowerPoint เขา้มาในโครงการ 

การแทรกสไลด ์PowerPoint จะมีรูปแบบเดียวกับการสรา้งโครงการด้วยสไลด์ของ PowerPoint โดยมีวิธีการ
ดังน้ี 

1. ส าหรับโครงการที่ต้องการแทรกสไลด ์Microsoft PowerPoint คลิกที่เมนู Insert > PowerPoint 
Slide หรือ Ctrl+Shift+P จะปรากฏหน้าตา่งส าหรับเลือกต าแหน่งของสไลด์ที่ต้องการแทรกสไลด์ใหม่ 

2. ท าการเลือกต าแหน่งที่ต้องการแทรกสไลด์ใหม่ แล้วคลิก OK  
 

 
 
3. จะปรากฏหน้าตา่ง Open เพ่ือท าการเลือกไฟล ์Microsoft PowerPoint ที่ต้องการแทรกสไลดเ์ข้ามาใน

โครงการ 
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4. ท าการเลือกไฟล์ของ Microsoft PowerPoint ที่ต้องการแทรก และคลิก Open 
5. โปรแกรมจะท าการประมวลผล เพ่ือน าเข้าไฟล์ Microsoft PowerPoint ที่เลือก ให้รอจนกระทั่งการ

ประมวลผลเสร็จสิ้น จะปรากฎหน้าต่าง Convert PowerPoint Presentations 
 

 
 

6. เลือกสไลดท์ี่ต้องการแทรก แล้วคลิก OK สไลด์ที่เลือก จะถูกแทรกเข้ามาในต าแหน่งที่ก าหนดไว้ 
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7. การสรา้งโครงการในรปูแบบสไลดว์า่งเปลา่ 

เป็นการสร้างโครงการ ที่ต้องท าการจัดวางและก าหนดสิ่งต่างๆ ลงไปบนสไลด์ที่ว่างเปล่า มีลักษณะเหมือนการสร้างสไลด์
ใน Microsoft PowerPoint 

7.1 ขั้นตอนการสร้างโครงการในรูปแบบสไลด์ว่างเปล่า 
1. สามารถเริ่มต้นสร้างโครงการจากหน้าต่างเริ่มต้นโปรแกรม ที่ส่วนของเมนู Create New ท าการเลือก 

From Blank Project > หรือ Ctrl+N จะปรากฎหน้าต่าง New Blank Project ข้ึนมา 
 

 
 

2. ก าหนดขนาดของโครงการ หรือสไลด์ที่ต้องการที่เมนู Select แล้วคลิก OK 
3. จะปรากฎสไลด์ว่างเปล่าข้ึนมาที่ส่วนพ้ินที่การท างาน (Work Space) ซึ่งสามารถท าการแทรกวัตถุ แทรก

สไลด์ และตกแต่งแก้ไขโคงการได้ 
 

7.2 การแทรกวัตถุรูปแบบต่างๆ และก าหนดคุณสมบัติในโครงการ 
1. การแทรกวัตถุในโครงการ สามารถท าได้ 2 วิธี คือ  

1) การเลือกวัตถุที่ต้องการจากแถบเครื่องมือ Object Tool เช่น Text Caption, Rollover 
Caption, Button หรือ Click box 
2) การแทรกรูปภาพ แอนิเมชั่น หรือ Widget จากเมนู Insert  

2. เม่ือท าการแทรกวัตถุที่ต้องการแล้ว สามารถก าหนดคุณสมบัติของวัตถุน้ันๆ ได้ โดยการ double click ที่
วัตถุ จะปรากฎหน้าต่าง Properties 

3. ในส่วนของ Properties วัตถุแต่ละชนิดจะสามารถก าหนดค่าคุณสมบัติต่างๆ ได้แตกต่างกัน ดังน้ี 
1) Item Name – ก าหนดชื่อให้กับวัตถุ 
2) Visible – ก าหนดให้แสดงผลหรือมองเห็นวัตถุหรือไม่ 
3) Character – ก าหนดรูปแบบการแสดงผลตัวอักษร เช่น รูปแบบตัวอักษร ขนาดตัวอักษร ตัวหนา 

ตัวเอียง และสีตัวอักษร เป็นต้น 
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4) Format – ก าหนดรูปแบบการจัดวางตัวอักษร เช่น ชิดซ้าย กึ่งกลาง เป็นต้น 
5) Action – ก าหนดเหตุการณ์ เม่ือมีการด าเนินการกับวัตถุชนิด button หรือ click box  
6) Timing – ก าหนดระยะเวลาในการแสดงผลของวัตถุน้ันๆ โดยสามารถก าหนดระยะเวลาในการแสดงผล 

(Specific time) หรือก าหนดให้แสดงผลตลอดช่วงเวลาการแสดงผลสไลด์น้ันๆ (Rest of slide) หรือ
ก าหนดให้แสดงผลตลอดช่วงเวลาของโครงการ (Rest of project) 

7) Transition – ก าหนดลูกเล่นให้กับการแสดงผลวัตถุ ในการปรากฎเข้ามาบนสไลด์ (Fade In) และ
ออกจากสไลด์ (Fade Out) 

7) Position & Size – ก าหนดต าแหน่ง และขนาดของวัตถุ 
 

7.3 การจัดการแถบไทม์ไลน์ 
แถบไทม์ไลน์ (Timeline) จะแสดงเลเยอร์ของวัตถุทั้งหมดที่อยู่บนสไลด์ โดยแต่ละเลเยอร์ก็จะมีช่วงระยะเวลาที่ใช้

ในการแสดงผล 
1. การจัดล าดับของวัตถุบนแถบไทม์ไลน์ 

แถบไทม์ไลน์จะแสดงเลเยอร์ของวัตถุทั้งหมดบนสไลด์ ในลักษณะแท่งสี่เหลี่ยมแนวนอน ถ้าวัตถุมีการซ้อนทับ
กัน สามารถท าการจัดล าดับของวัตถุใหม่ได้ โดยน าเมาส์คลิกค้างไว้ที่เลเยอร์ของวัตถุ แล้วลากข้ึน-ลง หรือลากซ้าย-ขวา 
เพ่ือจัดล าดับการแสดงผลตามต้องการได้ 

 

 
 

2. การซ่อนวัตถุบนแถบไทม์ไลน์ 
ในการสร้างโครงการ แต่ละสไลด์อาจมีการแทรกวัตถุเข้ามามากมาย เพ่ือไม่ให้สับสนหรือยุ่งยาก สามารถท า

การซ่อนวัตถุน้ันๆ ไว้ เพ่ือสะดวกและอิสระในการจัดการกับวัตถุอ่ืนๆ ที่ไม่ได้ถูกซ่อน โดยท าการเลือกสไลด์ที่ต้องการ 

แล้วคลิกที่จุดวงกลมสีด า ที่อยู่แถบเดียวกับ  ของเลเยอร์ของวัตถุที่ต้องการซ่อน ซึ่งจะปรากฎเครื่องหมายกากบาท
ที่เลเยอร์น้ันๆ แสดงว่าวัตถุถูกซ่อนไว้แล้ว หากต้องการยกเลิกการซ่อนวัตถุ ให้คลิกที่เครื่องหมายกากบาทอีกครั้ง 
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3. การล็อควัตถุบนแถบไทม์ไลน์ 
การล็อควัตถุบนสไลด์ นิยมใช้ในกรณีที่ต้องการเคลื่อนย้ายวัตถุโดยไม่ให้มีผลกระทบต่อต าแหน่งของวัตถุอ่ืนๆ 

ที่อยู่บนสไลด์เดียวกัน วัตถุที่ท าการล็อคไว้จะไม่สามารถเคลื่อนย้ายหรือท าการแก้ไขใดๆ ได้ จนกว่าจะท าการปลดล็อค

ก่อน โดยท าการเลือกสไลด์ที่ต้องการ แล้วคลิกที่จุดวงกลมสีด า ที่อยู่แถบเดียวกับ    ของเลเยอร์ของวัตถุที่

ต้องการล็อค ซึ่งจะปรากฎเครื่องหมาย  ที่เลเยอร์น้ันๆ แสดงว่าวัตถุถูกล็อคไว้แล้ว หากต้องการยกเลิกการล็อควตัถุ 

ให้คลิกที่เครื่องหมาย  อีกครั้ง 
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8. การสรา้งตารางสารบญัของโครงการ (Table of Content) 

ตารางสารบัญ จะช่วยให้ผู้ใช้สามารถเลือกดูเฉพาะเน้ือหาที่ต้องการ หรือสามารถไปยังเน้ือหาที่ต้องการได้อย่างสะดวก 
และรวดเร็ว นอกจากน้ียังสามารถจัดกลุ่มให้กับสไลด์ของโครงการ และจัดรูปแบบของตารางสารบัญได้ด้วย โดยข้ันตอนในการ
สร้างตารางสารบัญมีดังน้ี 

1. เปิดโครงการที่ต้องการสร้างตารางสารบัญ 
2. คลิกที่เมนู Project > Table of Contents… จะปรากฎหน้าต่างของ Skin Editor 
3. คลิกที่เช็คบ็อกซ์ “Show TOC” เพ่ือก าหนดให้โครงการแสดงตารางสารบัญ ซึ่งจะปรากฎรายการของสไลด์

ทั้งหมดของโครงการข้ึนมา 

 
 

4. คลิกที่เช็คบ็อกซ์ เพ่ือเลือกจ านวนสไลด์ที่ต้องการสร้างตารางสารบัญ 
5. ตารางสารบัญจะแสดงอัตโนมัติที่ส่วนของ Skin Editor ทันที 
6. สามารถก าหนดรูปแบบของตารางสารบัญได้ที่ค าสั่ง Skin โดยโปรแกรมจะมีหลายรูปแบบให้เลือกใช้ 
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9. การสง่ออกและเผยแพรโ่ครงการ 

เม่ือท าการสร้างโครงการในรูปแบบที่ต้องการเรียบร้อยแล้ว ต่อมาคือส่งออกโครงการให้อยู่ในรูปแบบที่ต้องการ เ พ่ือ
น าไปใช้ในการเผยแพร่ หรือน าเสนอต่อไป โดยส าหรับ Adobe Captivate 5.0 สามารถส่งออกโครงการได้หลากหลาย
รูปแบบ เช่น ไฟล์ SWF, Media, E-mail หรือ Print ดังน้ี 

9.1 การส่งออกโครงการในรูปแบบไฟล์ SWF 
ไฟล์ SWF เป็นไฟล์วิดีโอที่มีขนาดเล็ก นิยมน ามาใช้แสดงผลบนเว็บไซต์ เน่ืองจากมีขนาดเล็ก ท าให้สามารถโหลด

ไฟล์วิดีโอมาแสดงบนหน้าเว็บได้รวดเร็วกว่าไฟล์วิดีโอรูปแบบอ่ืน ซึ่งในการแสดงผลไฟล์ SWF คอมพิวเตอร์จ าเป็นต้องติดตั้ง
โปรแกรม Adobe Flash Player โดยมีข้ันตอนดังต่อไปน้ี 

1. เปิดโครงการที่ต้องการส่งออก จากน้ันคลิกที่เมนู File > Publish หรือ Shift+F12 จะปรากฎหน้าต่าง 
Publish 

2. คลิกเลือก Flash (SWF) เพ่ือก าหนดให้ส่งออกเป็นไฟล์ SWF  
 

 
 

3. ในส่วนของ Flash (.swf) Options สามารถก าหนดค่าได้ ดังน้ี 
1) Project Title – ก าหนดชื่อให้กับไฟล์ส่งออก 
2) Folder – ก าหนดไดเรกทอรีให้กับไฟล์ส่งออก สามารถคลิก Browse เพ่ือเลือกไดเรอกทอรีที่ต้องการ 
3) Publish to Folder – ก าหนดให้โปรแกรมสร้างโฟล์เดอร์ส าหรับเก็บไฟล์ส่งออกให้อัตโนมัติ 
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4. ในส่วนของ Output Option สามารถก าหนดค่าได้ ดังน้ี 

1) Output Option – เป็นการเลือกรูปแบบการส่งออกไฟล์เพ่ิมเติม เช่น บีบอัดไฟล์, ส่งออกไปยัง HTML 
หรือ ส่งออกไปยังไฟล์ PDF 

2) Flash Player Version – ก าหนดเวอร์ชั่นของ Flash ส าหรับการส่งออกไฟล์โครงการ เช่น 
Flash Player 10 หรือ Flash Player 9 
5. เม่ือก าหนดค่าต่างๆ เรียบร้อยแล้ว คลิกปุ่ม Publish 
6. โปรแกรมจะส่งออกโครงการไปยังไดเรกทอรีหรือโฟลเดอร์ที่ก าหนดไว้ โดยเม่ือกระบวนการเสร็จสิ้น โปรแกรม

จะแจ้งการส่งออกเสร็จแล้ว คลิก Yes ถ้าต้องการแสดงผลโครงการ หรือคลิก No ถ้าไม่ต้องการแสดงผลโครงการ 
 

 
 

 
9.2 การส่งออกโครงการในรูปแบบไฟล์ EXE 

เป็นการส่งออกโครงการในลักษณะ Stand Alone ซึ่งไฟล์สามารถเล่นหรือแสดงผลเองได้ โดยไม่ต้องใช้
โปรแกรมใดๆ โดยมีข้ันตอนดังต่อไปน้ี 

1. เปิดโครงการที่ต้องการส่งออก จากน้ันคลิกที่เมนู File > Publish หรือ Shift+F12 จะปรากฎหน้าต่าง 
Publish 

2. คลิกเลือก Media เพ่ือก าหนดให้ส่งออกเป็นมีเดียไฟล์ 
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3. ในส่วนของ Media Option สามารถก าหนดค่าได้ ดังน้ี 
1) Select Type – ก าหนดชนิดของมีเดียไฟล์ที่ต้องการส่งออก เช่น ไฟล์ exe, ไฟล์ f4v 
2) Project Title – ก าหนดชื่อให้กับไฟล์ส่งออก 
3) Folder – ก าหนดไดเรกทอรีให้กับไฟล์ส่งออก สามารถคลิก Browse เพ่ือเลือกไดเรอกทอรีที่ต้องการ 
4) Custom .exe icon – ก าหนดรูปแบบของไอคอน ส าหรับไฟล์ส่งออก 

4. ในส่วน Output Options สามารถก าหนดค่าได้ ดังน้ี 
1) Output Option – เป็นการเลือกรูปแบบการส่งออกไฟล์เพ่ิมเติม เช่น บีบอัดไฟล์ (Zip), แสดงผลเต็ม

จอ (Full Screen) 
2) Flash Player Version – ก าหนดเวอร์ชั่นของ Flash ส าหรับการส่งออกไฟล์โครงการ เช่น 

Flash Player 10 หรือ Flash Player 9 
5. เม่ือก าหนดค่าต่างๆ เรียบร้อยแล้ว คลิกปุ่ม Publish 
6. โปรแกรมจะส่งออกโครงการไปยังไดเรกทอรีหรือโฟลเดอร์ที่ก าหนดไว้ โดยเม่ือกระบวนการเสร็จสิ้น โปรแกรม

จะแจ้งการส่งออกเสร็จแล้ว คลิก Yes ถ้าต้องการแสดงผลโครงการ หรือคลิก No ถ้าไม่ต้องการแสดงผลโครงการ 


